CHAPTER 10

Using Digital Elevation Models
Digital Elevation Models (DEM’s) store continuously varying variables such as
elevation, groundwater depth or soil thickness. Digital Terrain Models (DTM’s) are
digital representations of altitude and are frequently used in hydrological, erosion and
engineering geological studies.
Digital Elevation Models are made via the following techniques:
- Photogrammetrical techniques. These methods use stereoscopic aerial
photographs or satellite images to sample a large number of points, with X, Y and
Z values, by means of advanced photogrammetrical equipment. After this, the
points are interpolated into a regular grid (raster). Unfortunately, the method is
rather time consuming (each sampling point has to be measured by an expert
through the lowering of a floating mark on the stereo model) and requires
photogrammetrical experts, and a set of detailed control points. At present,
photogrammetrical software packages are on the market which can automatically
generate a DTM from stereoscopic scanned aerial photographs or satellite images
in combination with a number of control points for which (x,y, z) coordinates are
known. In general, it can be said that photogrammetrical methods, whether
analogue or digital, are mainly used by mapping agencies and certain companies
specialized in photogrammetry and map production.
- Point interpolation techniques. When point data is available for an area,
obtained via ground surveys using theodolites and/or Global Positioning Systems
(GPS), point interpolation can be used to generate a DEM. For complex terrain, the
interpolation techniques are also rather complex, taking into account breaklines of
slope. Point interpolation techniques will be treated in chapter 11.
- Interpolation of contour lines digitized from existing maps. When neither
existing DEMs derived from photogrammetric techniques nor detailed point data is
available, the contour information on existing topographic maps is the only source
from which you can generate a DEM. In that case the contour lines are digitized
and interpolated. The interpolation of contour lines is a standard procedure in
ILWIS to generate a DEM. This is what we will discuss in the next section.
Digital Elevation Models can either be stored in vector or in raster format. DEMs in
vector format are often in the form of Triangulated Irregular Networks (TIN), which
can be seen as a set of polygons in the form of triangles where the 3 corners of each
triangle are known height values. Each triangle has a uniform slope steepness and
slope direction. When the terrain is more complex, the number of triangles needed to
represent the terrain increases.
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In ILWIS, the TIN structure is not used. DEMs are always in the form of raster maps,
with a value domain. Each pixel in the raster map contains the altitude of the center
of the pixel. Using a large pixel size will therefore result in more general DEMs (a
smoother topography). Especially when the mapped changes in topography occur at
distances smaller than the pixel size, the slope angles derived from the DEM may
lead to an underestimation of the actual slope angles in the field. When the pixel size
is chosen too large, ridges and small streams may be missed. The accuracy of a DEM
depends very much on the detail of the contour lines, that were used for the
interpolation, and the scale of the original topographic map from which the contour
lines were digitized. The larger the scale of the map, and the smaller the contour
interval, the more accurate the DEM will be.

!

In the Properties of a DEM raster map, you can switch on the Interpolation
check box. This will calculate height on the fly within pixels. This is extremely
important when using a georeference Direct Linear or a georeference
Orthophoto (see section 6.4.1.).

Digital Elevation Models have a very wide range of applications. They form one of
most frequently used spatial data sources in GIS projects. They are also the basis for
a large number of derivative information. The most important application areas of
DEMs are:
- Slope steepness maps, showing the steepness of slopes in degrees, percentages,
or radians for each location (pixel).
- Slope direction maps (also called slope aspect maps), showing the orientation
or compass direction of slopes (between 0˚-360˚).
- Slope convexity/concavity maps, showing the change of slope angles within a
short distance. From these maps you can see if slopes are straight, concave or
convex in form.
- Hill shading maps (or shadow maps), showing the terrain under an artificial
illumination, with bright sides and shadows. Hill shading is used to portray relief
difference and terrain morphology in hilly and mountainous areas. The gray tones
in a hill shading map represent the amount of reflected light, depending on the
relative orientation of a certain location towards the illumination source. The
illumination source is usually chosen at an angle of 45˚ above the horizon in the
northwest.
- Three dimensional views showing a bird’s eye view of the terrain from a user
defined position above the terrain.
- Cross-sections indicating the altitude of the terrain along a line and represented
in a graph (distance against altitude).
- Volume maps (or cut-and-fill maps), generated by overlaying two DEMs from
different periods. This allows you to quantify the changes in elevation that took
place as a result of slope flattening, road construction, landslides etc.
- Creation of Ortho-images from aerial photographs or satellite images. With the
help of DEMs, aerial photographs and satellite images can be corrected for tilt
distortion and relief displacement.
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In this chapter, first the method for generating a DEM will be explained, followed by
a series of exercises dealing with the derivative maps.
Before you can start with the exercises, you should start up ILWIS and change to the
subdirectory C:\ILWIS 3.0 Data\Users Guide\Chapter10, where the data files for
this chapter are stored.

☞

•
•

Double-click the ILWIS icon on the desktop.
Use the Navigator to go to the directory: C:\ILWIS 3.0 Data\Users Guide\
Chapter10.
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10.1 Creating a Digital Elevation Model: contour interpolation
In this section, you will create a DEM for the Cochabamba study area from digitized
contour lines. The contour lines were digitized manually. See section 3.4 for
information on how to digitize contour lines.
You should make sure to have digitized the contour lines a little bit outside of the
study area where interpolation should take place, because at the borders of the
interpolated area, artifacts may occur.
The creation of a Digital Elevation Model from a segment map is done with the
Contour interpolation operation. This operation works in two steps:
- Segment to raster conversion. First the segment map is converted to raster,
using a georeference in which the pixel size, the number of lines and columns, and
the minimum and maximum X and Y coordinates of the map are defined. It is
important to make sure that the pixel size is not too large, in relation to the
maximum spacing of the contour lines. Otherwise it may happen that two contour
lines may have to be located in the same pixel, which is of course not possible. In
this case the program will select one of the two values of the contour lines and will
omit the other, which may lead to problems in the interpolation. The input segment
map should be a value map. The raster map resulting from the segment to raster
conversion will contain values for those pixels covered by a contour line. All other
pixels in the map remain undefined.
- Contour interpolation. A linear interpolation is made between the pixels with
altitude values, to obtain the elevations of the undefined values in between the
rasterized contour lines. The output of the contour interpolation is a raster map in
which every pixel has a value. The interpolation method is based on the Borgefors
distance method. The operation calculates, for each undefined pixel in between two
rasterized segments (outcome of the first step), the shortest distance towards the
two nearest isolines (see Figure 10.1). The height value (Hp) for a pixel (p),
between two contour lines is calculated as:
Hp = H2 +(d2 /(d1 + d2)*(H1 - H2))
where: Hp is the calculated height value for an output pixel, H1 and H2 are the height
values of the higher and lower contour lines and d1 and d2 are the distances from the
pixel to the higher and lower contour lines (see Figure 10.1).

Figure 10.1: Two contour lines (H1 and H2) and the shortest distances (d1 and d2) towards an

output pixel (p).
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During the interpolation, quite some time is needed to calculate the shortest distance
towards two known values, which has to be done for every undefined pixel. This
calculation is done iteratively; the program calculates forwards and backwards (from
top line to bottom and vice versa) until no more changes occur. Then a linear
interpolation is performed using the two distance values. The linear interpolation
returns the height values for the undefined pixels. During the calculation, several
Megabytes of hard disk are used for storing temporary maps.
In this exercise segment map Contour , with a value domain, is used to generate the
DEM.

☞

•

Click with the right mouse button on segment map Contour and select
Contour Interpolation from the context-sensitive menu.
The Interpolate Contour Map dialog box is opened.

•
•
•

Type Dem as Output Raster Map.

•

Accept all other defaults and click Show.

Select GeoReference Cochabamba .
Type for the Description: DEM created from the segment map
Contour .

The calculation may take some time, depending on the computer configuration and
other programs that are working simultaneously. It is advised to close other programs
while performing contour interpolation: this will speed up the process considerably.
The Display Options - Raster Map dialog box will be opened after the operation is
finished.
The default representation which is indicated in the Display Options dialog box is
the same one as was used for the segment map Contour : the user-defined
Representation Height .

☞

•

Click OK in the Display Options – Raster Map dialog box. The map is displayed.

•
•

Click several places in the map and read the altitude values.

•

Double-click the map Dem in the Layer Management pane. The Display
Options – Raster Map dialog box is reopened.
Select Representation Clrstp12 and click OK. The map is now displayed
with a Representation Clrstp12 .

Now we will show you that even within pixels an interpolation can take place.

☞

•
•

Zoom in on the Dem , until you see the pixels clearly.
Check the value of a pixel by moving the mouse pointer within a pixel.
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•

From the File menu, choose Properties, and select the Interpolation check
box. Click Apply.

•

Check the height value within a pixel once more and close the map window
when finished.

Selecting the Interpolation check box is especially important when you want to use
the DEM in a georeference Direct Linear or a georeference Orthophoto. In regular
map calculations, however, still 1 value per pixel will be used.
If you wish you can create a new representation to make the Dem appear sliced. A
DEM can also be classified or sliced permanently through the operation Slicing.
Ranges of values of the input map are grouped together into one or more output
classes. The output map resulting from the Slicing operation is a map with the
domain type group. A domain group should be created beforehand or during the
operation using the Slicing dialog box. The domain group lists the upper boundaries
of the groups and the group names. A detailed description of the Slicing procedure
was given in the sections 6.6.2 and 7.5.
Use of additional point heights
The interpolation of contour lines will give wrong results for hilltops, which are
enclosed on all sides by a contour line. They will appear as flat areas with the same
altitude as the contour line surrounding it. To improve this, it is possible to combine the
segment map, containing the contour lines, with a point map, containing the altitudes of
the hilltops. Both maps should first be converted to raster and then combined into one
raster map. This raster map will serve as the basis for the interpolation.

☞

•
•
•
•
•
•

Display segment map Contour with Representation Height .
From the Layers menu select Add Layer.
The Add Data Layer dialog box appears. Select the Point Map
Spotheight and click OK. The Display Options – Point Map dialog box
is opened.
Press the Symbol button. The Symbol dialog box appears.
Select Symbol: + Plus . Clear the check box Stretch. Accept all other
defaults and click OK. You are back in the Display Options – Point Map
dialog box.
Click OK. The point map is displayed on top of the contour lines.

When you zoom in on one of the crosses you will see that it is located within a
closed contour line on a hilltop. Of course the same procedure is valid for closed
depressions.

☞
392

•

Close the map window.
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Now we have to rasterize the point map and combine it with the rasterized segment
map into a single map, which will be the input map for the interpolation. The
rasterized segment map ContourRasterized was created already during the
previous contour interpolation operation.

☞

•

Double-click the Point to Raster operation in the Operation-List. The
Rasterize Point Map dialog box is opened.

•

Select the Point Map Spotheight . Select GeoReference Cochabamba ,
accept all other defaults and click Show. The point map is rasterized and the
Display Options – Raster Map dialog box is opened.

•
•

Click OK to display the rasterized point map.
Close the map after you inspected the result.

Now that both the point map and the segment map are rasterized, you can combine
them.

☞

•

Type the following formula on the Command line of the Main window:
Combination = IFUNDEF(Spotheight,
ContourRasterized,Spotheight) ↵

•

The Raster Map Definition dialog box is opened. Click Show to calculate
and display the Combination map. After the calculation the Display
Options - Raster Map dialog box appears.

•

Click OK to display the map.

In the MapCalc formula above, it was tested whether a pixel in the map
Spotheight is undefined. If that is so, the map Contour is used in the output
map. If not, then the values from the raster map Spotheight are taken.
With the Combination map you can do the actual interpolation. The interpolation
expression on the Command line will be used instead of the Contour Interpolation
dialog box, since the dialog box only accepts a segment map as input.

☞

•

Type the following formula on the Command line of the Main window:
Dem1 = MapInterpolContour(Combination) ↵
The Raster Map Definition dialog box appears. Click Show. The map
Dem1 is calculated; when the Display Options dialog box appears click OK.
The map is now displayed.

•

From the Layers menu, select Add Layer. The Add Data Layer dialog box
appears

•

In the Add Data Layer dialog box select point map Spotheight and click
OK. The Display Options - Point Map dialog box is opened.

•

Press the Symbol button. The Symbol dialog box appears.
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•

Select Symbol: + Plus . Clear the check box Stretch. Accept all other
defaults and click OK. You are back in the Display Options - Point Map
dialog box.

•

Select the check box Text and click OK. The point map Spotheight is displayed on top of Dem1 .

•

From the File menu in the map window, select Open Pixel Information.
The pixel information window is opened.

•

Add map Dem via drag and drop to the pixel information window and check
the altitude values of the hilltops with the mouse.

•

Close the map window and the pixel information window.

The combination of contour lines with additional point heights is very important for
hilly areas, where a lot of isolated hills can occur. Normally the altitude of isolated
hilltops is indicated on topographical maps. If they are not available you will have to
make an “educated guess”, taking into account the value of the enclosing contour
line, the contour interval and the overall steepness of the terrain.
If you only have elevation data stored as points, the contour interpolation cannot be
used for generating a Digital Elevation Model. In that case you will have to use a
point interpolation operation, such as Moving Surface or Kriging. This will be
demonstrated in chapter 11.
Summary: Contour interpolation
The creation of a Digital Elevation Model from a segment map is done with the
Contour Interpolation operation. This operation works in two steps:

- Segment to raster conversion. First a segment map is converted to raster, using
a georeference.
- Contour interpolation. A linear interpolation is made between the pixels with
known altitude values, to obtain the elevations of the undefined values in between
the rasterized contour lines. The output of the contour interpolation is a raster map
in which each pixel in the map has a value.
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10.2 Filters applied on Digital Elevation Models
Filtering is the calculation of pixel values in an image or a raster map based on the
pixel values of the central pixel and its neighbours. In other words, filtering is a
process in which, usually a window of 3x3 or 5x5 pixels, is moved over the map, to
calculate an output value for the central pixel in the window according to its
neighbours.
Filters are commonly used in image processing (see chapter 6) but can also be
applied to raster maps (see chapter 9). A special group of filters is used to calculate
slope steepness, slope shape (convex, concave) and shadow from Digital Elevation
Models. The existing standard filters in ILWIS that can be applied on DEMs are
given in Table 10.1.
Table 10.1:

List of standard filters in ILWIS that can be applied on DEMs.

Filter type

Application

DFDX
DFDY
DFDUP
DFDDN
D2FDX2
D2FDY2
D2FDXDY
LAPLACE
SHADOW

Detects slope differences in x-direction.
Detects slope differences in y-direction.
Calculates slope differences in the upward diagonal direction.
Calculates slope differences in the downward diagonal direction.
Detects slope shape differences in x-direction.
Detects slope shape differences in y-direction.
Calculates slope shape differences in all diagonal directions
Calculates slope shape differences in all diagonal directions
Applies artificial illumination (from the northwest) to the DEM.

Creating a hillshading map
In this exercise, the ILWIS standard filter Shadow is applied on the Digital Elevation
Model Dem to create a shaded relief image. The shadow filter simulates sun
illumination on the surface, with the sun in the northwest. The shaded relief image is
merely used for display.

☞

•

Double-click the Filter operation in the Operation-list. The Filtering dialog
box appears.

•
•
•
•

Select Raster Map: Dem

•

Accept all other defaults and click Show. After the map has been calculated,
the Display Options - Raster Map dialog box will appear.

•

In the Display Options - Raster Map dialog box, select Representation
Gray and click OK. The map is now displayed.

Select Filter Name: SHADOW .
Type Hillshading in the text box Output Raster Map.
Type for the Description: Hill shading map generated from the map
Dem .
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When you display the map, you can see the relief coming out of the map. The map
shows the representation of the mountains under an artificial illumination, as if the
sun is shining from the NW. Steep slopes directed to the SE are dark, and slopes
directed to the NW are very bright. You can generate hillshading maps with
illumination from other directions by saving a copy of the Shadow filter and then
editing the copy.

☞

•

Close the map window.

Using gradient filters
The most important types of filters that can be used on a DEM are called gradient
filters. With the help of the gradient filters Dfdx and Dfdy , horizontal and vertical
gradients are calculated for each pixel. The gradient maps are used to produce slope
steepness maps as well as slope direction maps.
The gradient filter can be seen as a window which moves over the map, starting from
the upper left pixel in the map. Each value of the filter is multiplied by the
corresponding pixel value in the map. The results, for all the pixels in a filter are
added up, and the resulting value is multiplied by the gain and stored in the central
pixel of the output map. Then, the window moves one pixel to the right, and the
procedure is repeated. After finishing with the last pixel of the first line, the window
moves to the first pixel of the second line. In this way, a new value is calculated for
every pixel in the map. In Figure 10.2, a schematic example is given of a horizontal
gradient filter.

Figure 10.2: The filtering procedure, applying a horizontal gradient filter on a DEM. The direction

of the horizontal and vertical filters is not important. Filters -1 0 1 and
1 0 -1 will
give the same value but with opposite sign, e.g. in the calculation of slope angles.

The simple horizontal gradient filter shown in Figure 10.2 is not an ILWIS standard
filter; it is just an understandable example. The standard gradient filters DFDX and
DFDY in ILWIS are a little more complicated and give a better estimation of the first
derivative. They are presented in Figure 10.3.
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Figure 10.3: The vertical (DFDY) and horizontal (DFDX) gradient filters used in ILWIS.

!
☞

To inspect the contents of standard filters, choose Customize Catalog from the
View menu in the Main window, and select the Include System Objects check
box. You can open the standard filters now by double-clicking them in the
Catalog.

•

Double-click the Filter operation in the Operation-List. The Filtering dialog
box is opened.

•
•
•

Select Raster Map Dem and Filter Name DFDX .

•

Click OK in the Display Options - Raster Map dialog box. The map is
now displayed.

•

In the map window, open the pixel information window and add the map
Dem . Zoom in on the map until you can see individual pixels. Compare the
values of the map Dx for a certain pixel, with the difference of the altitude of
its left and right neighbours in the map Dem .

•

Repeat the procedure to create a gradient map in the y-direction, but select
the Filter Name DFDY and type Dy for the Output Raster Map name.

•

Close the map window and the pixel information window when you have finished the exercise.

Type for Output Raster Map: Dx .
Accept all other defaults and click Show. The map is calculated, after which
the Display Options - Raster Map dialog box is opened.

Calculating slope shape
Before continuing with the creation of a slope steepness map, you will have a look to
another set of filters that are useful for DEMs. A number of filters can be used to
investigate which parts of the terrain are convex (showing negative values in the
output map) or concave (positive values in output map). Flat areas and uniform slopes
obtain the output value 0. The following filters can be used:
- D2FDX2. This 1x5 filter detects slope shape differences in x-direction.
- D2FDY2. This 5x1 filter detects slope shape differences in y-direction.
- LAPLACE. This 3x3 filter can be used to detect slope shape differences in both x
and y directions.
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- D2FDXDY. This 5x5 filter detects slope differences in both x and y direction (second derivative).

☞

•

Click raster map Dem with the right mouse button and select Image
Processing, Filter. The Filtering dialog box is opened.

•
•
•

Select Filter Name: D2FDXDY .

•

Click OK in the Display Options - Raster Map dialog box. The map is
now displayed.

•

Check some of the pixel values and close the window afterwards.

Type for the Output Raster Map: Shape .
Accept all other defaults and click Show. After the map has been calculated,
the Display Options - Raster Map dialog box will appear.

The map shows many different values, showing the degree of concavity/convexity of
the slope. Negative values indicate convex slopes while positive values represent
concave slopes. Values close to zero represent straight slopes or flat areas.
It would be better to classify this map into three classes: Convex , Straight and
Concave . We can do this by reclassifying the map. We can use the Slicing operation
(as was explained in chapter 7) for classifying the value map Shape , but since there
are only three units, we can also use a MapCalc formula. The resulting map will be a
class map with three classes. The domain will be created semi-automatically after
writing the formula.

☞

•

Type the following formula on the Command line of the Main window:
Shapeclasses = IFF(Shape<-0.5,“Convex slope”,
iff(Shape>0.5,“Concave slope”,“Straight slope”)) ↵

The Raster Map Definition dialog box appears.
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•

Click the Create button next to the drop-down list box of the Domain. The
Create Domain dialog box is opened.

•

Enter the Domain Name Shapeclasses and click OK. The Domain
Class editor is now opened

•

Close the Domain Class Editor. You are now back in the Raster Map
Definition dialog box. Click Show.

•

Answer Yes to the question: Add string ‘Concave slope’ to domain
‘Shapeclasses’ .

•

Answer Yes to the question: Add string ‘Straight slope’ to domain
‘Shapeclasses’ .

•

Answer Yes to the question: Add string ‘Convex slope’ to domain
‘Shapeclasses’ .

•

Open map Shapeclasses and check its contents. Close it when you are
finished.
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The map Shapeclasses shows for each pixel whether the slope is convex, straight
or concave. However, since nearly every pixel is having a different class, the result is
difficult to read. To improve this we could use a majority filter, which will assign the
predominant class name of every 5x5 input pixels into an output pixel.

☞

•

Filter the map Shapeclasses using the Majority filter and generate the
result map Shapeclasses_final .

•
•

Display this map and compare it with the map Shapeclasses .
After that, close all map windows.

Filters used to calculate internal relief
With the help of filters and digital elevation models, it is also possible to calculate
internal relief, which is expressed as the maximum elevation change within 1 hectare,
or within 1 square kilometer. The filter type that can be used for this is the rank order
filter. A rank order filter will place all pixel values that occur within the filter
window (in a 3x3 filter that would be 9 values) in an increasing order. The user can
then select which rank value should be taken. So, in the case of a 3x3 filter, the first
rank value would be the minimum of the 9 pixels, the fifth value would be the
median and the ninth value would be the maximum.
For calculating internal relief, we would need the minimum and the maximum value
within a sufficiently large area (for example within a hectare) and then calculate the
difference.
Georeference Cochabamba contains the pixel size of the raster maps (including the
DEM) of the data set we are using. This pixel size is 20 meters. So in order to
calculate the internal relief per hectare (100x100m), we need to use a filter of 5 rows
by 5 columns.

☞

•

Select raster map Dem in the Catalog, press the right mouse button and
select Image Processing, Filter. The Filtering dialog box appears.

•
•

Select Raster Map Dem and Filter Type Rank Order .
Clear the check box Predefined because we want to use a user-defined
filter.

•

We want to use a 5x5 filter so enter 5 for the number of Rows and 5 for the
number of Columns.

•
•

Enter the value 1 for the Rank. This will give us the minimum value.
Type Demmin for the Output Raster Map, accept all other defaults and
click Define.

The map Demmin , giving the minimum altitude within each hectare will be
calculated later. Now we also need to define a map for the maximum altitude value
per hectare.
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☞

•

Repeat the procedure as described above but with the following exceptions:
- The Rank should now be 25 (the maximum value of 5x5 pixels).
- The Output Raster Map name should be: Demmax .

•

Click Define. Type the following formula on the Command line of the
Main window:
Internal_relief = Demmax-Demmin ↵
The Raster Map Definition dialog box is opened.

•

Select Domain Value , change the Value Range to 0-1000 (assume a
maximum height difference of 1km in 1 hectare), and the Precision to 1.0 .

•

Type for the Description: Internal relief in meters per hectare
and click Show.

•

First the maps Demmin and Demmax will be calculated, then map
Internal_relief will be calculated, and the Display Options dialog box
of the last map will appear.

•
•

Choose Representation Pseudo and click OK. The map is displayed.

•

Add maps Demmin and Demmax to the pixel information window and check
some values by clicking in the map.

•

Close the map and the pixel information window when done.

From the File menu in the map window, select Open Pixel Information. The
pixel information window is opened.

Summary: filters used on Digital Elevation Models.
The following filters are useful to apply on Digital Elevation Models:
- Shadow filter. The shadow filter simulates sun illumination on the surface, with
the sun in the northwest. The shaded relief image is merely used for display purposes.
- Gradient filters. With the help of the gradient filters DFDX and DFDY, horizontal
and vertical gradients are calculated for each pixel.
- Slope shape filters. With the help of second derivative filters, such as
D2FDXDY, you can detect slope differences in both x and y direction, and calculate if the slope is convex, concave or straight.
- Rank order filters. With the help of rank order filters it is also possible to calculate internal relief in a digital elevation model, expressed for example as the maximum elevation change within 1 hectare, or within 1 square kilometer.
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10.3 Creating a slope map
In principal, a slope angle or slope percentage can be calculated for each pixel in a
raster map, as shown in Figure 10.4.

Figure 10.4: Slope steepness calculation. h is the height difference between two points and d is

the distance between them on the map.

In ILWIS, the slope angle or slope percentage can be calculated in X and Y direction
using a digital elevation model (DEM), gradient filters (DFDX and DFDY) and a
map calculation formula. The following steps have to be done to calculate a slope
map:
- Constructing a DEM (see section 10.1).
- Calculating gradient maps in X and Y direction (see section 10.2).
- Calculating the slope angle or slope percentage using map calculation formulas.
In this exercise the gradient maps Dx and Dy (created in the previous section), are
used to generate a slope map. The pixel size in these gradient maps is 20 meters and
the domain type is value.

☞

•

Type the following formula on the Command line of the Main window:
Slope_percentage = ((HYP(Dx,Dy))/pixsize(Dem)) *100 ↵

In this formula HYP (hypotenuse) is an internal MapCalc/TabCalc function to
calculate the positive root of the sum of square Dx plus square Dy (Pythagoras rule),
Dx is the horizontal gradient map, and Dy the vertical gradient map. In this formula,
the numerator is divided by the pixel size, using the internal function
pixsize(map) , since the gradient is expressed in meters difference per pixel and
the result should be in meters difference per meter. The value 100 in the formula
gives the slope in percentages

☞

•
•

The Raster Map Definition dialog box is opened.

•

Click OK. The map is now displayed.

Type for the Description: Slope map in percentages and click Show.
The map is calculated and after that the Display Options - Raster Map
dialog box is opened.
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As you will see, slope values in this map may well rise above 100%. Note: the
following slope values are the same: 30° = 58%, 45° = 100%, 60° = 173%, 80° =
567%. Now you will calculate a slope map in degrees.

☞

•
•

Close the map Slope_percentage .
Type the following formula on the Command line:
Slope_degrees = RADDEG(ATAN((HYP(Dx, Dy))/pixsize(Dem))) ↵

ATAN and RADDEG are internal MapCalc/TabCalc functions. The ATAN function

calculates the arctan (tan-1), and returns real values in radians in the range
-1/2 π to 1/2 π. The function RADDEG is used to convert the radians to degrees.

☞
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•
•
•

The Raster Map Definition dialog box is opened.
Select a Value Range from 0 to 90 and a Precision of 1.0 .
Click Show. The map is calculated and after that the Display Options –
Raster Map dialog box is opened.

•
•

Click OK. The map is now displayed.

•

Close the map and pixel information window when finished.

From within the map window, open the pixel information window and add
the map Slope_ percentage to it. Compare the values and calculate if
both maps are correct in respect to each other.
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10.4 Slope direction (aspect)
The slope direction (or slope aspect) can also be calculated by combining gradient
maps which result from applying horizontal and vertical filters on a digital elevation
model (DEM).
In this exercise, a slope direction map is calculated for the Cochabamba area. The two
maps with the horizontal and vertical gradients (Dx and Dy ) have already been
created in section 10.3.

☞

•

Type the following formula on the Command line in the Main window:
Aspect = RADDEG(ATAN2(Dx,Dy)+pi) ↵

RADDEG and ATAN2 are internal MapCalc/TabCalc functions. ATAN2(y,x) returns
the angle in radians of two input values; x is horizontal, y is vertical. The function
RADDEG is used to convert from radians to degrees. The value for pi (π) is
3.141592653589.... The map Dx is the horizontal gradient map, and Dy the vertical

gradient map. The formula results in values between 0˚ and 360˚, according to the
degrees of the geological compass. For flat areas no slope direction can be calculated.
They will obtain an undefined value. In order to be able to display them correctly we
need to make a domain Compass , for which we will create a special representation
later on.

☞

•

In the Raster Map Definition dialog box click the Create button next to the
drop-down list box of the Domain. The Create Domain dialog box is
opened.

•
•
•

Type the Domain Name: Compass .

•
•

Click Show to calculate the map.

Type for the Description: Compass direction.
Enter the Min and Max: 0 and 360 , the Precision: 1.0 and click OK. You
are now back in the Raster Map Definition dialog box.
In the Display Options - Raster Map dialog box, select Representation
Gray and click Show. The map will be displayed.

We still need to make a good representation for the map.

☞

•

Reopen the map’s Display Options dialog box and click the Create representation button. The Create Representation dialog box is opened.

•

Type the Representation Name: Compass , the Description: Compass
directions and click OK. The Representation Value editor is now
opened, showing the limits 0 in black and 360 in white.
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The values 0° and 360° should have the same color (as they represent the same
compass direction). Furthermore, you want to see the relief properly (i.e. sun light
from the west). We will therefore use the following values and colors (Table 10.2):
Table 10.2:

☞

Values and color for representation Compass.

Degrees

Color

360
270
180
90
0

Gray
White
Gray
Black
Gray

•

Open the Edit menu and select the Insert Limit command or press the Insert
Limit button. The Insert Limit dialog box is opened.

•
•

Insert the limits and edit the colors according to Table 10.2.

•

Enter 25 for the number of Stretch Steps and click OK.

Select from the Edit menu the command Stretch Steps. The Stretch Steps
dialog box appears.

Now the representation is ready. It goes from white for western aspects to gray for
northern and southern aspects to black for eastern aspects.

☞

•
•

Close the Representation Value editor.

•

Add the segment map Drainage and/or Contour to the map window.
Display the segments in a single color (e.g. Blue or SandyBrown ).

•

Check the slope directions by clicking on the pixels and close the map window afterwards.

Representation Compass is now selected in the Display Options dialog
box of the map. Click OK. The map is displayed.

It is also possible with the Slicing operation to classify the aspect map. The
procedure how to do this is clearly described in the ILWIS Help topic “How to
calculate an aspect map”.
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10.5 Display 3D
A Digital Elevation Model (DEM) can be visualized in 3 dimensions using a
georeference 3D. The DEM or perspective view will initially appear as a line grid. It
is possible to superimpose on this DEM/perspective view any map (satellite images,
thematic maps) with the same coordinate system. The initial 3D grid lines of the
georeference 3D have to be edited so that the user can specify the view parameters
(altitude, rotation, distance, vertical exaggeration, etc.). This defines the perspective
of the observer in relation to the 3D model.
In the following exercise the Digital Elevation Model Dem created in section 10.1 is
displayed as a three dimensional view. A line grid in X and Y directions will be
displayed. By modifying the view parameters you can adapt the grid so that the 3D
model meets your requirements.

☞

•

Double-click the Display 3D operation in the Operation-list. The Display
3D dialog box is opened.

•

In the Display 3D dialog box, click the Create button next to the
GeoReference drop-down list box. The Create GeoReference dialog box
is opened.

•
•
•

Type Dem3D in the text box GeoReference Name.

•
•

Click OK. The Display Options - 3D Grid dialog box is opened.

Type 3D view, Cochabamba in the text box Description.
Select raster map Dem in the list box DTM, accept the number of Rows,
Columns, and click OK. Now you are back in the Display 3D dialog box.
Accept the defaults and click OK.

The 3-D view is now displayed with default values. These default view parameters
can be modified by editing the georeference 3D.

☞

•

From the Edit menu, select the command GeoReference. The
GeoReference 3D editor is opened.

•

Maximize the window so that the whole 3D view (grid lines) and all parameters in the 3D View Parameter pane are visible.

By changing the values in this editor you can change the view direction, altitude, etc.
This is explained in Figures 10.5 and 10.6.
You can imagine a 3D view as the view that you would have from an area when you
are in a helicopter, which is at a fixed position. This position is called the view point.
The view point is at a certain height (i.e. view height) in meters and at a certain X
and Y coordinate in the map. From the view point you are looking at the study area.
The point in the center of your study area is called the focal point, which also has a
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certain X and Y coordinate. You can draw an imaginary line between the focal point
and the view point, which is called the view axis (see Figure 10.5).

Figure 10.5: The parameters used to define a 3D view. The view point is the point from which

you look, and the focal point is the center of the area to which you look. The view
point is at a certain height (view height), and at a certain horizontal rotation with
respect to the N-S line. The line between the view point and the focal point is
called the view axis and has a certain distance and a certain angle with respect to a
vertical line through the focal point (vertical rotation).

The focal point is at a certain distance from the view point. This distance is the real
distance between the view point and the focal point.
The viewing axis also has a certain horizontal rotation with respect to a line in N-S
direction. This is called the horizontal rotation (angle). The horizontal rotation angle
is taken as a negative value when the viewing axis is rotated in western direction and
positive when rotated in eastern direction. For example: when you are looking from
the SW, the horizontal angle is -45°, and when you are looking from the NE, the
horizontal angle is +135°.
The viewing axis also makes an angle with respect to a vertical line. This is called the
vertical rotation (angle). The vertical rotation angle is 0° when you are exactly above
the focal point, and it is 90° when your helicopter is at the same level as the focal
point (i.e. as if you were standing on the ground at a certain distance).
The viewing angle is defining the opening angle with which you are looking to the
focal point. You can imagine it as a cone, with the viewing axis as the center, starting
at the view point. When the viewing angle is 180° degrees, it is as if you are looking
at the terrain with a fish eye lens.
The last parameter to explain is the scale height. With the scale height, you can
exaggerate the height differences in Z (as compared to X and Y).
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Figure 10.6: Parameters used to define the 3D view. The coordinates of the view point and the

focal point can be entered, as well as the distance between the two (real distance).
The horizontal rotation angle is the angle between the line connecting the focal
point and the view point with respect to a N-S oriented line. The viewing angle is
the angle with which you look to the focal point (it is the sum of the two angles at
both sides of the view axis which connects the view point and the focal point).

In the following exercise you will learn how to work with the different parameters, in
order to get an optimal 3D view. The first impression is that it is quite complicated to
enter so many parameters manually. However, many of these are interrelated, and
there are a few which are crucial: Horizontal Rotation, Vertical Rotation,
Distance, Viewing Angle and Scale Height.
First, we will adapt the 3D view to simulate that you are looking from the south to
the terrain and from a position close to the ground surface (high vertical rotation).

☞

•

In the GeoReference 3D Parameter pane, change the Horizontal
Rotation to 0 and the Vertical Rotation to 82 , and press Enter.

•

Accept all other defaults and press the Redraw button
dow.

in the map win-

For your information, the Focal Point is located approximately at (801850 ,
8081200 ), the Distance to the Focal Point is approximately 20400 m and the
View Point Height is approximately 5700 m. The values above are just an
indication. You will probably not get exactly the same values yourself.
The 3D view should now be similar to the one shown in Figure 10.7.
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Figure 10.7: A 3D view from the south with a high vertical rotation.

To evaluate the effect of using a higher view point (i.e. a smaller vertical angle), you
will now change the 3D view again.

☞

•

Change the Vertical Rotation to 40 , and press Enter. Note that the View
Point and the View Point Height change automatically.

The view should now be similar to the one shown in Figure 10.8. Note that you now
see a larger part of the area but less height differences.

Figure 10.8: A 3D view showing the effect of a smaller vertical rotation.

Now you will see the effect of changing the horizontal rotation. We will change the
vertical rotation back to the original value.

☞
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•
•

Change the Vertical Rotation to 82 .

•

Click the Redraw button, or press Enter.

Change the Horizontal Rotation to 30 . This means you are now looking
from the south-southeast towards the north-northwest.
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The view should now be similar to the one shown in Figure 10.9. Note that the 3D
view is now rotated.

Figure 10.9: A 3D view from the south-southeast (30° rotation from the south).

The next parameter that we will change is the Viewing Angle. Decreasing the
viewing angle is similar to zooming in with a camera. You will see a smaller area, but
in more detail.

☞

•

Change the Viewing Angle to 60 and press Enter.

The view should now be similar to the one shown in Figure 10.10. Note that you will
see a smaller area than before.

Figure 10.10: A 3D view showing the effect of a larger viewing angle.

Finally, you will look how you can change the position of the focal point. The focal
point is always in the exact center of the 3D view in the window. It is the point to
which you are looking and this point will be displayed at the center of the window.
You could change the focal point location by typing the coordinates, but this is rather
tedious. There are much faster methods to change the focal point location and the
other interrelated parameters. You can also set the focal point interactively by clicking
in the grid line window.

☞

•

Open the Edit menu and select the Focal Point command and click with the
mouse pointer somewhere in the grid line map (e.g. near the small mountains
at the foreground) to set the new focal point.
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Now we will use the small DEM window which appears above the 3D view
parameters. This window can be used to interactively specify the View Point and the
Focal Point by drawing a line.

☞

•

First, click the Extend Boundaries button. The Extend Window by
Percentage dialog box appears.

•

In the Extend Window by Percentage dialog box extend all four sides of
the window with 50 %.

•
•

Now, click the Set View Point button.

•
•

If you like, adapt the Viewing Angle to a somewhat larger value, e.g. 95 .

Click somewhere in the white space in the small DEM window, e.g. somewhere at the bottom left; keep the left mouse button down and move the
pointer to the center of the map; then release the mouse button. The 3D view
will change immediately.
Practice some more until the grid lines nicely fill the area of the georeference
3D window.

Selecting the best parameters for defining a 3D view seems quite difficult when you
are doing it for the first time. However, if you practice some more with the editor,
you will see that a number of parameters are interrelated.
When you have finished editing the parameters of the GeoReference 3D, you can
leave the editor by pressing the Exit Editor button
on the Toolbar in the
GeoReference 3D editor.

☞

•

Click the Exit Editor button in the Toolbar of the GeoReference 3D editor
or open the File menu and choose Exit Editor.

3D view with raster draping
In the previous exercise you have created and edited a 3D view using only grid lines
for the 3D display. It is also possible to drape a raster map on top of the 3D view. In
this exercise you will create a 3D view using a hillshading map.

☞

•

Double-click georeference Dem3D in the Layer Management pane or click
the right mouse button in the window and select Display Options. The
Display Options - 3D Grid dialog box appears.

•

Clear the check box Grid, select the check box Raster Drape and select
raster map Shadows from the drop-down list box.

•

Click OK. The Shadows map is now draped over the 3D view.

As you can see the display is still rather course. This is because you accepted the
default pixel size of 3. With the pixel steps, you can define the number of rows and
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columns from the raster map that should be used to drape the raster map over the 3D
model. The best result is obtained by selecting a pixel step of 1. This will, however,
lead to a much slower display. Therefore, use larger pixel steps to edit the initial 3D
view, and use a pixel step of 1 for the final view.

☞

•

In the Layer Management pane double-click Dem3D . The Display Options
- 3D Grid dialog box appears.

•

Change the Pixel steps to 1 and click OK. The 3D view is redisplayed slowly, but more accurately.

•

In the map window, press the right mouse button and select Display
Options. The Display Options – 3D Grid dialog box appears.

•

In the Display Options – 3D Grid dialog box, select the Grid check box,
change the Grid Distance to 1000 m and click OK.

•

Close the map window when you have seen the result.

Once you finished creating and editing the georeference 3D, you can display any
existing raster map as a 3D view by using the Display 3D operation.

☞

•

Double-click the Display 3D operation in the Operation-list. The Display
3D dialog box is opened.

•

In the Display 3D dialog box, select Dem3D1 from the GeoReference dropdown list box and click OK. The Display Options - 3D Grid dialog box is
opened.

•

Clear the Grid check box, select the check box Raster Drape and select
raster map Landuse .

•

Accept the default Representation and click OK. The Landuse map is now
draped over the 3D view.

The result of this exercise can be saved as a map view.

☞

•

In the map window open the File menu and select the Save View command.
The Save View As dialog box appears.

•

In the Save View As dialog box type 3Dmapview for the Map View Name
and click OK. The map is saved as a map view.

Adding vector layers to a 3D view
One of the major advantages of the 3D views in ILWIS is that they remain
georeferenced, so that you can display other data layers on top. You can also use the
pixel information window to retrieve information of raster and vector maps,
combined with attribute tables, while moving the mouse pointer through the 3-D
view.
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☞

•

Drag-and-drop polygon map Cityblock to the map window in which the
3D view 3Dmapview is displayed. The Display Options -Polygon Map
dialog box is opened.

•

Change the Boundary Width to 0. In this way only the polygons are shown
in color, without boundary lines.

•

Change the amount of Multiple Colors to 31 and click OK. The polygon
map is drawn in the perspective view.

•
•

Also add segment map Drainage to the map window.
Zoom in if you like and save the result as a map view.

It is also possible to use the pixel information window in combination with a 3D
view.

☞

•

In the map window, open the File menu and select the Open Pixel
Information command. The pixel information window is opened. You may
have to add raster map Landuse yourself to the pixel info window.

•

Move with the mouse pointer to one of the city blocks displayed in the 3D
view, and read the information from the pixel information window.

•

Close the map window and the pixel information window.

To obtain a new raster map in 3D, you can use the Apply 3D operation.

☞

•

Double-click the operation Apply 3D in the Operation-list. The Apply 3D
dialog box is opened.

•

Select Raster Map Landuse , GeoReference Dem3D1 and type for the
Output Raster Map name 3DLanduse .

•
•

Click Show. The new map is now created. This will take a while.
After that the Display Options - Raster Map dialog box is opened. Click
OK to display the 3D view and close it after you have seen the result.

The resolution of the output raster map may be rather course. The resolution is
determined by the size of your georeference 3D (default 300 lines x 400 columns)
when the georeference 3D was created, and how well you made the initial 3D grid
lines fit into this when you edited the georeference 3D.
Summary: 3D-display
- A Digital Elevation Model (DEM) can be visualized in three dimensions by
creating and editing a Georeference 3D.
- A georeference 3D can be created with the Display 3D operation.
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- Once the initial georeference 3D is displayed, you have to edit the georeference and
make the 3D view according to your wishes. This can be done in the
Georeference 3D editor. The user can specify the view parameters (altitude,
rotation, distance, vertical exaggeration, etc.) to define the perspective of the
observer in relation to the 3D model.
- A georeference 3D or 3D view can be displayed as grid lines but you may also use
a raster drape (i.e. any satellite image or thematic map). When you use a raster
drape, the raster map should use a georeference that has the same coordinate
system as the georeference of the 3D view.
- Once you finished editing the georeference 3D, you can display any raster map in
3D by using the Display 3D operation and optionally combine this with one or
more vector layers. The results can be stored as a map view.
- To produce an output raster map in 3D, you can use the Apply 3D operation. On
the output, you can overlay again any vector map(s), and the result can be stored as
a map view.
- The main advantage of the 3D views as obtained from either Display 3D or Apply
3D is thus that the 3D maps remain georeferenced. You can thus display other
vector layers on top of the 3D views, and you may use pixel information to retrieve
information of raster and vector maps, combined with attribute tables, while
moving the mouse pointer through the 3D view.
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10.6 Creating cross-sections from a DEM
In this last exercise, dealing with the use of Digital Elevation Models, a simple
method is presented to generate altitude information from a DEM along profiles. The
profiles are segments, which can be digitized with the mouse or the digitizer. The
objective is to display in a graph the distance from the starting point of the profile
along the X-axis and the altitude along the Y-axis.
In order to do so we have to make the following steps:
- Digitize a line along which you want to create a cross-section.
- Use the operation Segment to Points, to convert the digitized line to regularly
spaced points.
- Open the point map as a table, and calculate the column Distance , which is the
distance from the starting point of the profile.
- Read the values of the altitude from the DEM for the coordinates specified in the
table.
- Plot the distance against the altitude in a graph.
For this exercise you will use a predefined segment map Profile . If you want
digitize profiles yourself, you should make sure that each profile consists of one
single segment, with a unique code. It is possible to have several profiles in the same
file, but then they should be coded differently (e.g. Profile1 , Profile2 , etc.). For
the conversion from segments to points, only one segment should be present in the
file. If you have more profiles, the process should be done for each profile
individually and the conversion from segment to point should be preceded by the
Mask Segments operation, which you use to copy one single profile segment into
another file.

☞

•

Click with the right mouse on the segment map Profile , and select
Vectorize, Segment to Point from the context-sensitive menu. The
Segments to Points dialog box is opened.

•

Select the option button Distance and enter 50 for the Distance. This
means that along the segment, points will be stored at every 50 meters.

•

Type for the Output Point Map Profile and click Show. A point map is
made containing points at every 50 meters along the profile line. The
Display Options - Point Map dialog box is opened.

•
•
•

Click OK to display the point map.
Zoom in on a section to verify that the map contains individual points.
Close the point map.

Now that the point map is generated, we can open it as a table, and read the altitude
values from the DEM for each point.
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☞

•

Click with the right mouse on the point map Profile , and select the command Open as Table from the context-sensitive menu. The point map is
now shown as a table with two columns: Coordinate and Name .

•

Open the View menu in the table window and select the Command Line.
The table window should now give you a Command line.

•

Type the following formula on the Command line of the table window:
Distance =(%R-1) * 50 ↵

•

Click OK in the Column Properties dialog box.

The objective of this formula is to use the record indexes (the values shown in the left
gray column). The predefined variable %R refers to these record indexes. The formula
results in distances in meters from the start of the profile.
Now we will read for all the points, the values of the Digital Elevation Model, from
the pixels with the same coordinates as shown in the table. This can be done with the
MapValue function.

☞

•

Type the following formula on the Command line of the table window:
Altitude = MapValue(Dem,Coordinate) ↵

•

Click OK in the Column Properties dialog box.

Now we have the distance as well as the altitude, and the profile can be drawn.

☞

•

From the Graph menu, select the command New Graph Window or press
the New Graph Window button in the Toolbar of the table window. The
Graph dialog box is opened.

•

In the Graph dialog box select the column Distance for the X-column and
the column Altitude for the Y-column and click OK. The Graph Options
sheet is opened.

•
•

Accept the default settings and click OK. The profile is now shown.

•

Close the graph and the table window.

If you like, you can adapt the descriptions for the X and Y-axis in the Graph
Options sheet; on the X-axis tab and the Y-axis (left) tab. On the X-axis
tab, you can also rotate the values along the X-axis (e.g. 90°).

In the previous exercise vector data (a segment map) is used to create a cross-section
through the terrain. It is also possible to use raster data as basis for the selection and
creation of a cross section e.g. using a particular line or column from a raster map.
How to do this is clearly described in the ILWIS Help topic How to calculate a
cross-section through the terrain (Advanced).
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